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Installation and Configuration 

Installing the ICS Software 

  

NOTE: Do not install the USB Security Key until after the Metrics ICS Software is 

installed and the PC is restarted.  The security key requires special drivers that are 

installed with ICS.  Windows Hardware Manager should detect the USB Security Key as 

Safenet USB SuperPro/UltraPro and install the driver automatically. 

 

The installation program for the Metrics ICS software installs all components necessary to 

run Metrics ICS. You can download the auto-extracting archive MTICS-43.exe from the 

Metrics Technology website under Downloads link of your Customer Portal page. Be sure 

to save the install file to your local hard disk before running the installation. Running the 

installation from the website will cause an installation error. You will need to register at 

our website to receive your log-in credentials to enter the Support/Customer 

Portal/Downloads area.  

 

NOTE:  You should also download the latest available HotFix release which can be found 

in the same software list and designated MTICS-43-HFXX.EXE where the XX is the 

version of the HotFix. HotFixes contain resolutions to any reported issues and some 

enhancements that have been added since the initial release of Metrics ICS 4.3 It is only 

necessary to apply the latest HotFix to your system since all updates are contained in the 

latest build. Save the HotFix file to your local computer and install it after the base Metrics 

ICS installation is complete. It is recommended that you make a backup archive of the 

latest HotFix you apply. These are removed from the website once the version is obsolete. 

 

Obtain a Codeword 

This codeword is obtained by registering your software with Metrics Technology.  Please 

visit our website at www.metricstech.com to register your software and obtain the 

codeword. A permanent or temporary codeword will be sent within 24 hours. 

Important Note for Customers upgrading from 

Version 3.7 or later  

The Metrics ICS setup program requires that you backup and uninstall the previous 

version.  To do this, please perform the following steps: 

 

DO NOT LEAVE YOUR BACKUP ARCHIVE IN THE METRICS DIRECTORY!  

COPY THE BACKUP.ZIP FILE TO A DIFFERENT LOCATION LIKE A USB DRIVE.  

http://www.metricstech.com/
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1. Go to the File Menu and select Backup 

2. Enter the name of the backup ZIP archive in the ICS directory (i.e. 

C:\METRICS\ICS\backup.zip) 

3. Allow the backup utility to complete then copy the .ZIP file to another 

drive location. 

 

Metrics ICS files are now be stored in the windows file system.  Existing tests should be 

opened and then saved in the Metrics\ics\projects directory. 

 

Procedure to Upgrade ICS from 4.0, 4.1, 4.2 to 4.3 

1.  Insert the Metrics ICS install CD into the CD-ROM drive of your computer.  

 

2. The CD-ROM should automatically start the MTICS-43.exe installation program.  

If the installation does not start automatically then select right click on the CD drive 

icon in Windows Explorer and then select "explore". Select the MTICS-43.exe 

application icon to start the installation program manually. 

 

  

 
 

3. Click Next button on the "Welcome" panel.  
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4. Read the "Software License Agreement" and click the I agree to the terms in the 

License Agreement button to agree to the terms. Then click Next. 

  

 
 

5. Choose "destination location" for installation and click the Next button.  
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 Note: It is recommended to select the default C:\Metrics\ as the location to 

 maintain compatibility with previous versions of the software backups.  

 

 
 

6. Click the Install button to begin the Metrics ICS installation. 

 

 
 

7. The Safenet Sentinel Pro driver installation will now be started to install the security 

license components.  
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8. Select Modify setup type and click the Next button.  

 

        

 

9. Click Next to start select the custom installation. 
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10. Click Install to start the Sentinel Driver installation. 

 

 

 
 

11. Allow the installation to complete. 
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12. Then click Finish to continue with the Metrics ICS installation. 

 

 

 
 

13. Allow the Metrics ICS installation to complete.  
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14. Then click Finish to complete the installation. 

 

15. After the installation is finished, re-start the computer.  

 

 
 

16. Connect the USB Security Key to the USB port of your computer. The Windows 

Hardware Manager should detect the USB device as Safenet USB 

SuperPro/UltraPro and should automatically install the driver for the device. 

 

 Note: It is recommended the security plug be connected directly to the computer 

instead of through a USB hub or keyboard port if possible.   
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Procedure to Install ICS 4.3 (new installation) 

1.  Insert the Metrics ICS install CD into the CD-ROM drive of your computer.  

 

2. The CD-ROM should automatically start the MTICS-43.exe installation program.  

If the installation does not start automatically then select right click on the CD drive 

icon in Windows Explorer and then select "explore". Select the MTICS-43.exe 

application icon to start the installation program manually.  

 

The installation will check for any prerequisites and start the Prerequisites Wizard 

to install the necessary software. Please note installation of some of these software 

components requires acceptance of the 3rd Party license agreements displayed 

during installation. Installation of some components can take some time so you 

should allow more time for installation if these components are not already installed 

on your workstation PC. 

 

 
 

3. Click Next button on the "Welcome" panel.  
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4. Click Next button on the "Prerequisites" panel.  

 

 

 
 

5. Click I have read and accept the license terms then click the Install button on the 

"Microsoft .NET Framework" panel.  
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6. Click Finish to continue. 

 

 

 
 

7. Click I have read and accept the license terms then click the Install button on the 

" Microsoft Visual C++ 2010 Redistributable " panel.  
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8. Click Finish to continue. 

 

  

9. Click Next button on the "Welcome" panel. 
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10. Read the "Software License Agreement" and click the I agree to the terms in the 

License Agreement button to agree to the terms. Then click Next. 

 

11. Choose "destination location" for installation and click the Next button.  
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 Note: It is recommended to select the default C:\Metrics\ as the location to 

 maintain compatibility with previous versions of the software backups.  

 

12. Click the Install button to begin the Metrics ICS installation. 

 

 

13. The Safenet Sentinel Pro driver installation will now be started to install the security 

license components.  



Metrics ICS Installation and Getting Started Guide     18  

 

 
 

14. Read the "Software License Agreement" and click the I agree to the terms in the 

License Agreement button to agree to the terms. Then click Next. 

 

 

 
 

15. Select "Complete" setup type and click the Next button.  
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16. Click Install to start the Sentinel Driver installation. 

 

 

 
 

17. Allow the installation to complete. 
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18. Then click Finish to continue with the Metrics ICS installation. 

 

 

 
 

19. Allow the Metrics ICS installation to complete.  
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20. Then click Finish to complete the installation. 

 

21. After the installation is finished, re-start the computer.  

 

 
 

22. Connect the USB Security Key to the USB port of your computer. The Windows 

Hardware Manager should detect the USB device as Safenet USB 

SuperPro/UltraPro and should automatically install the driver for the device. 

 

 Note: It is recommended the security plug be connected directly to the computer 

instead of through a USB hub or keyboard port if possible.   
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Metrics Codewords 

Metrics Technology software products use a combination of a hardware Security Key and 

Codeword. The unique combination of a Codeword and Security Key allows full 

functionality the software product to be run on any workstation PC or laptop.   

  

Software Codeword Information 

There will be a codeword for each software component ordered. This information is 

made up of two (2) parts, the License Registration Information and Codeword 

Information. We encourage all customers to register their software with Metrics 

Technology. Only registered users will receive technical support for their products. 

Customer ID 

The Customer ID is a number that has the form IAXXXXXA. Where the X is a 

number. Variations include IHXXXXA, MHXXXXXA, and MKXXXXXA. This 

number must match the number on the Security Key. 

Product Desc 

This is the Product Description. This will be the name of the product, such as 

Metrics ICS or Metrics ICS. 

 Product ID 

The product ID is MTICS and should be entered in the ID field 

Version 

This is the version of the software i.e. 4.3.0 

Note: The version number and the codeword are matched. Thus, customers who 

have not purchased an upgrade will not be able to run software without purchasing 

an upgrade with a correlating codeword.  

Codeword Serial 

Example Codeword:AWRZI-XXC6Z-HK3EM-1RHU0-GUJ8A-UPX0R 
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Entry of the Codeword Serial Number 

 

Note: It is recommended that you cut and paste the codeword from the registration e-mail 

sent from Metrics Technology Customer Service. Be careful not to copy any spaces before 

or after the alpha-numeric codeword string.  

 

The software Codeword Serial number can be manually entered in ICS. If typing the 

codeword from the keyboard be careful not to transpose letters or numbers. The letter I can 

be confused for the number 1 and the letter O can be mistaken for the number 0. Be careful 

not to include any space before or after the code word string. 

 

  

To Enter the ICS Codeword Serial number: 

1. Open the ICS program.  In ICS select the menu item Help » Codeword to open the 

Software License Codeword window.  

  

   
 

2. Enter the ICS Codeword Serial number supplied on the product registration 

certificate or e-mail. 

 

3. Click the OK button.  
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Introductory Information 

 

Goal of This Manual   

The goal of this manual is to provide a process for the user to be able to create a test 

and analyze the data with Metrics ICS.  A test setup will be created that measures the 

Threshold Voltage of a MOSFET device.  The measured data will then be plotted and 

the Vth value will be extracted. 
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Chapter 1 - ICS Getting Started Guide 

 

Introduction 

The first Chapter of the Self-Paced Guide introduces the Metrics ICS software. This 

Chapter also provides important information on software versions and support. 

 

Please note that each Chapter builds upon the information presented in the previous 

Chapters. It is recommended that the Guide is followed in the order presented. 

 

 

Topics Covered 

• What is Metrics ICS Software?  

• Overview of Metrics ICS Software  

• Updating Versions  

• Support  
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What is Metrics ICS Software? 

The Metrics ICS Software is an application designed for semiconductor 

characterization applications. Measurements for different technologies can be created 

in a matter of minutes without programming. 

Metrics ICS Controls: 

• Semiconductor Parameter Analyzers  

• C-V Meters  

• Other Source Meters 

  

Overview of Metrics ICS Software 

Metrics ICS Software provides an environment for the collection of data in three 

steps: Setup, Execute, and Analyze. The Setup of a Measurement typically takes no 

more than 1-2 minutes. 

ICS supports several measurement modes to accommodate most testing methods. 

The Analysis tools in ICS include plotting and data extraction. Once the functions 

are created, they can be saved with the data. 

The advantage of ICS is that once a test is created and saved it can be re-opened 

and used again, including the analysis.



 

Metrics ICS Installation and Getting Started Guide     28  

Determining Software Version 

The software version and build date are very important when requesting support. 

Please be prepared to provide this information when seeking support. 

To determine the software version: 

1. Open the Metrics ICS Software.  

2. Click the Help menu item.  

3. Click the About item. 

 

 

Updating the Metrics ICS Software 

Please keep your software up to date by downloading and installing the Metrics 

Technology HotFixes.  Your software will occasionally remind you to check for 

HotFixes.  HotFixes are critical updates for any discovered defects. Often the issues 

addressed in the updates are ones that you may just now be encountering.   

 

Metrics Technology also provides a Service Pack when necessary. A Service Pack 

will contain all HotFixes and new program features. Once a Service Pack has been 

created and verified by Metrics Technology, it is placed on our website; 

www.metricstech.com. Please note the Service Packs are very large and will take 

time to download depending upon your connection speed. Once downloaded the file 

is an .EXE application. 

  

It is recommended that you make an archive disc copy of any HotFix or Service Pack 

you apply to your system. 

http://www.metricstech.com/
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Support 

Metrics Technology provides technical support to customers for one year after the 

purchase of the Metrics software.  This support period includes a ninety-day period 

when telephone support is available.  The remainder of the year’s support is provided 

by email. Information on how to set-up instruments can be found under the HELP 

tab of the software. Please visit our website at www.metricstech.com to register your 

software and obtain your log-in information. 

 

If you are a customer that has registered and been provided log-in credentials you can 

access our Knowledge Base through your Customer Portal. If your issue is not 

addressed in the Knowledge Base it is most efficient to assist you if you submit a 

support ticket through your Customer Portal. Please provide the following 

information: 

 

1. Your software License Number (also known as Customer ID (CID) / 

Registration number). The sequence will be IAXXXXXA, IHXXXXXA or 

MKXXXXXA, etc. (X represents a number). 

 

2. Version of software and last HotFix applied. If you are using a currently 

supported version be sure you have applied the latest HotFix (HF##) available 

at our website accessed through your customer portal. The issue you may be 

experiencing may have been addressed in the latest Hotfix. The latest Hotfix 

contains all previous HotFix resolutions. 

 

3. A list of equipment you are using to test your devices. 

 

4. The ICS project file or VBScript algorithms being executed. 

 

5. Screen shots of the error code (Alt->Prt Scr, or for MAC keyboard press Shift-

Command-4) to capture the error window. 

Images sent from a phone camera are often illegible. 

http://www.metricstech.com/
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Chapter 2- Selecting Instruments 

 

Introduction 

This Module introduces the Metrics ICS (Interactive Characterization Software) 

measurement engine and demonstrates how to create test setups with it. 

  

Topics Covered: 

• Selecting an Instrument  

• Configuring the Instrument  

• Polling an Instrument 
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Selecting an Instrument Driver 

Before creating a measurement, ICS must know what instrument is being used. This 

is accomplished by configuring the instrument in the "Select Instrument " dialog in 

ICS. Once an instrument has been configured, ICS will remember this configuration. 

The only time ICS must be reconfigured is when the instrument is changed or the 

ICS40.INI file is deleted if requested by Metrics technical support. 

 

  

1. Click the Select Instrument button. 

2. Highlight the instrument to be added and click the Connect button. 
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Configuring the Instrument 

After the Instrument driver is selected, it must be configured.  

1. Highlight the instrument to be configured and click the Config button. 

2. Enter the GPIB address. 

 

 

Polling an Instrument 

To confirm that the instrument and ICS are communicating properly, poll the 

instrument. 

 

1. Click the Poll button. 

2. Click the OK button to close the Configuration window. 

3. Click the OK button to close the Instruments window.
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Chapter 3 - Creating Measurements 

 

 

Introduction  

The Module introduces the Metrics ICS (Interactive Characterization Software) measurement 

engine and demonstrates how to create measurements with it. Special demonstration drivers 

have been created to allow the development to be independent of the instrument. For details 

about the instrument drivers provided with Metrics ICS, please refer to the Metrics ICS 

documentation. The steps to creating a test method will be covered. 

 

 

  

Topics Covered 

• Creating a Sweep Measurement 

• Creating a Spot Measurement  

• Creating a Time-Based Measurement  
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Create a Sweep Measurement  

The following example demonstrates how to create a sweep measurement using ICS. This 

example uses the demonstration driver within ICS. 

 

To Create a Sweep: 

1. Open the setup editor. 

The Setup Editor is the place in ICS where the measurement is configured. It can be 

opened by clicking the Setup Editor button. 

 

 

  

2. Click New to create a new setup 
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3. Name the Measurement Setup 

Each measurement must have a unique name. Before the measurement can be created, 

it must be given a name. To name the measurement: 

 

a. Entering a name then click the OK button.  

       4. Select Source Units 

The source units correspond to the outputs of the instrument you are using. Metrics 

ICS provides a graphical way to document the connections for later reference. To add 

a source unit:  

 

a. Click on the Sources button to open the Source Units window.  

b. Highlight the specific unit.  

c. Click the blue box beside the device lead.   
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To remove a source unit: 

a. Highlight the attached unit.  

b. Click the blue box beside the device lead in the Setup Editor.  

c. Click the Yes button when asked if: 

    "Do you really want to remove the source". 

  

Note: The graphic is merely a representation of the device under test. The software 

does not strictly enforce any information from the graphic layout. Thus, the pin-out 

does not have to exactly match. It is only documentation of the connection and for 

reference only.  
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5. Configure Source Units. 

In this example, we are creating a sweep source, so we must configure the source unit 

properly. To setup a sweep source:  

Click the blue box beside the device lead in the Setup Editor.  

 

 

1. Select the stimulus type Voltage or Current. 

2. Select the values to be measured (see note below). 

3. Select the Source Mode. In this case we want it to be Sweep.  

4. Select the Source Type. Lin, Log 

5. Enter current of voltage compliance value 

6. Setup the sweep parameters.  

7. Select the sweep timing (see note below).  

Note: Most SMU's can only measure the signal that is not being sourced. Therefore, in this 

case we have selected the Stimulus to be Voltage resulting in the Current being measured. 

The values returned for Voltage in this case would be the calculated voltage steps. The 

opposite is true when the Stimulus mode is set to Current. The Sweep Time parameters are 

to control the rate of the sweep. Please note that these inputs vary for different instruments. 
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Create a Spot Measurement 

In this example, we will create a spot (or single point) measurement. Most of the steps are the 

same or similar to creating a sweep measurement. The first step is to open the setup editor. 

The setup editor can be opened by clicking the Setup Editor button. 

 

  

To Create a Spot Measurement: 

1. Open the setup editor. 

The Setup Editor is the place in ICS where the measurement is configured. It can be 

opened by clicking the Setup Editor button on the ICS toolbar. 
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2. Name the Measurement Setup. 

Each measurement must have a unique name. Before the measurement can be created, 

it must be given a name. To name the measurement: 

 

a. Click the New button and type in a name.  

b. Click the OK button after entering the name.  

c. Click the Sources button.  

The source units correspond to the outputs of the instrument you are using. Metrics 

ICS provides a graphical way to document the connections for later reference. To add 

a source unit: 

 

a. Click on the Sources button to open the Source Units dialog.  

b. Select the desired unit.  

c. Click the blue box beside the device lead.  
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To remove a source unit: 

a. Select the desired unit to delete from the Source Units list.  

b. Click the blue box beside the device lead. 

c. Click the Yes button when asked if you really want to delete the source unit. 

 

Note: The graphic is merely a representation of the device. The pin-out does not have 

to match exactly, rather it is only for reference.  
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3. Configure Source Units. 

In this example we are creating a spot source, so we must configure the source unit 

properly. To setup a spot source:  

 

 

1. Select the stimulus type.  

2. Select the values to be measured (see note below).  

3. Select the Source Mode. In this case we want it to be CONST.  

4. Setup the source bias.  

  

Note: Most SMU's can only measure the signal that is not being sourced. In this case 

we have selected the Stimulus to be Voltage resulting in the Current being measured. 

The values returned for Voltage in this case would be the calculated voltage steps. 

The opposite is true when the Stimulus mode is set to Current. Please note that these 

inputs vary for different instruments. 
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Creating a Time-Based Measurement 

In this example we will create a time-based measurement. Most of the steps are the same or 

similar to creating a spot measurement. The first step is to open the setup editor. 

 

 

To Create a Time-Based Measurement: 

1. Open the setup editor. 

The Setup Editor is the place in ICS where the measurement is configured. It can be 

opened by clicking the Setup Editor button.  
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2. Name the Measurement Setup. 

Each measurement must have a unique name. Before the measurement can be created, 

it must be given a name. To name the measurement: 

 

a. Click the New button and type in a name.  

b. Click the OK button after entering the name.  

c. Click the Sources button.  

  

The source units correspond to the outputs of the instrument you are using. Metrics 

ICS provides a graphical way to document the connections for later reference. To add 

a source unit:  
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a. Click on the Sources button to open the Source Units dialog.  

b. Highlight the desired unit.  

c. Click the blue box beside the device lead in the Setup Editor.  

To remove a source unit: 

a. Highlight the specific unit.  

b. Click the blue box beside the device lead in the Setup Editor.  

c. Click the Yes button.  

 Note: The graphic is merely a representation of the device. The software does not 

expect behaviors from the data. Thus, the pin out does not have to exactly match, 

rather it is only for reference.  
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3. Configure Source Units. 

In this example we are creating a time stimulus source, so we must configure the 

source unit properly. To setup a time stimulus source:  

  

 

a. Select the stimulus type.  

b. Select the values to be measured (see note below).  

c. Select the Time Bias and Compliance.  

  

Note: Most SMU's can only measure the signal that is not being sourced. Therefore 

in this case we have selected the Stimulus to be Voltage resulting in the Current being 

measured. The values returned for Voltage in this case would be the calculated voltage 

steps. The opposite is true when the Stimulus mode is set to Current. Please note that 

these inputs vary for different instruments.  
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 4. Set Time Parameters. 

We must specify the time interval that the measurements will be made. To setup the 

time parameters:  

 

 

a. Select the Time Units.  

b. Select the sampling type.  

c. Enter the Wait time.  

d. Enter the Start, Stop, and Step values. Select the Comply to Stop, 

option if desired.  
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5. Set Measurement Mode. 

We must specify the measurement mode as Time Meas. To setup the measurement 

mode:  

 

 

a. Select the Setup.  

b. Select the TIME MEAS mode.  
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Chapter 4 - Executing Measurements 

  

Introduction 

This Module details the execution of the measurement using ICS. 

 

  

Note: When creating new tests, it is necessary that the data be measured before the analysis 

is created. 

  

  

 

Topics Covered 

• Measurement Remote Control  

• The Data Window  
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Measurement Remote Control 

Metrics ICS contains a tool named the Measurement Remote Control. This control is activated 

by clicking the Measure button on the ICS toolbar. 

 

 
 

 

 

This toolbar contains buttons to begin the measurement as well as menus to select the 

measurement and mode. 

 

Note: The remote control window can be moved anywhere on the desktop. 

  

 
 

 

The Measurement Remote Control has four sections. 
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Section 1: Measurement Menu 

This pull-down menu allows the selection of a specific test to be executed. 

  

Section 2: Execute Buttons 

This section contains the buttons that will start the measurement. Several modes of 

measurement are available and the buttons correspond to the selected mode. 

  

Section 3: Measurement Mode Menu 

This pull-down menu allows the selection of the measurement mode. Most 

measurements are made in standard mode; however, ICS does support several 

specialized measurement modes which require this to be modified. 

  

Section 4: Stop Button  

This button allows the user to stop the measurement. 
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The Data Window 

When a new setup is created the spreadsheet is automatically created when a test setup is 

created. It will begin as a minimized window in the lower left corner of the ICS window. To 

view the data simply double-click the window that has the same name as the test setup. 

  

 
 

The Data window automatically returns the measured data and displays it. When parameters 

are extracted the values are also displayed. 

  

Note: ICS has a feature named "Enable DataView". To enable or disable this feature select 

Workspace from the Options menu. 
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Edit the DataView 

 

 
 

 
 

This feature allows the user to select that only data vectors that are chosen be displayed. It 

also allows the reordering of the data vectors as they appear in the data window. The default 

behavior is for the DataView to be disabled which displays all vectors for a chosen setup. 
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Sync the DataView with Microsoft Excel 

This feature allows the user to automatically synchronize all DataViews with a Microsoft 

Excel workbook.  The default behavior is for the DataView to be disabled which displays all 

vectors for each setup in separate tabs of the workbook. 

Note: ICS has a feature named "Enable DataView". To enable or disable this feature select 

Workspace from the Options menu. 

 

Note: ICS has a feature named "Sync dataview". To enable or disable this feature select 

Workspace from the Options menu. 

 
While the "Sync DataView" is selected all data will be automatically synced to the Excel 

spreadsheet.  You can create user defined macros to perform further analysis to create custom 

reports and save out to the file system in .XLS format. 

 

Notice that not only the measured data vectors are synced but also any transforms that have 

been setup for the raw data. 
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Chapter 5- Plotting Data 

  

 

Introduction 

This Module introduces the plotting tool of the ICS software. The plotting tool allows for the 

graphical analysis of data measured with ICS.  

 

Topics Covered  

• Creating a Plot 

• Editing a Plot  
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Creating a Plot 

The Metrics ICS software uses a custom plot tool to display plots and provide analysis features 

like read-out cursors and line fits. 

  

To create a new plot: 

 

  

 

1. Click the Plot button on the toolbar. 

2. Configure the plot. 

3. Click the Done button and the plot will be created. 
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Note: The plot is made from whatever data window is currently active. The name of 

the plot in the Window title is the setup name followed by a dash and a number. 

Multiple plots can be created from the same data set, the number will just increase. 
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Editing a Plot 

 
  

The plot window contains the editing tools for the plot. 

 

1. The Axis button reveals the tools to change the axis from linear to logarithmic and to 

auto scale the plot.  

2. The Cursors button allows the addition and control of cursors on the plot.  

3. The Fits button allows the application of curve fits related to the cursors.  

4. The Opts button presents several options for adding notes to the plot, overlaying plots, 

zooming features, and setup changes.  

  

These functions are discussed in great detail within the ICS Reference Manual. 
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Chapter 6- Extracting Data 

  

Introduction 

After executing a measurement, ICS can extract parameters. Once the procedures are defined, 

each time the measurement is run the calculations are performed automatically. 

 

This Module demonstrates how to extract parameters from the raw data using the Transform 

Editor within ICS. 

 

Topics Covered 

• The Transform Editor 

• Defining a Transform  

• Sharing Data Between Transforms 
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The Transform Editor 

Calculations are created within the Transform Editor. To open the editor, click the "Transform 

Editor" button on the ICS toolbar. 

 

 
 

 

 
  

The Transform Editor contains several areas: 

  

1. Transform Entry Box 

The location to enter the transform.  

2. Defined Transform List 

A list of all transforms defined for this setup.  
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3. Function List 

A predefined function(s) available for the calculation of parameters.  

4. Vector List 

A list of the measured and calculated data vectors.  

5. Constant List 

A list of constants that can be used in calculations.  

6. Edit Constant Button 

Allows constants to be defined and edited.  

7. Action Buttons 

Controls for the saving of transforms, deleting of transforms, and exiting the 

Transform Editor. 
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Defining a Transform 

Calculations are created within the Transform Editor. To open the editor, click the "Transform 

Editor" button on the ICS toolbar. 

 

 

 
  

To create a calculation: 

1. Enter the calculation in the "Transform" box. The calculation must be in the 

form result=function(vector)  

2. Click the Save button to save the new calculation.  

3. Once all calculations have been saved, click the Done button. 
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Sharing Data Between Transforms 

Data vectors from one setup can be shared with another setup in the same project file. For 

instance, if one setup (TEST2) measures the resistance from 0-1 Volts and the second (TEST1) 

from 1.1-2 Volts the data can be merged to form a full sweep from 0-2 Volts. 

  

To Share Data: 

We must first create two different setups with TEST2 being the sweep from 0-1 Volts 

and TEST1 being the sweep from 1.1 to 2 Volts. 

 

  

1. Open the Transform Editor and make sure the setup name is TEST2.  

2. Create a new Transform as shown above.  

3. Click the Save button.  
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The use of the transform result=setup name|vector name allows the data to be moved 

from one setup to another. 

 

 

After applying the transform result=setup name|vector name the data to be from 

TEST1 is displayed in the data window for TEST2. 
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Chapter 7 - Saving Data 

  

 

Introduction 

Metrics ICS saves the data within the standard Windows File System. This Module covers the 

data. Where it is stored, how it is stored, and how to retrieve it are covered. 

  

 

Topics Covered 

• Where is the Data? 

• Saving a Project  
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Where is the Data? 

Metrics ICS allows the data to be stored anywhere within the windows file system. 

 

Note: If you want the ICS Backup utility to save the data, make sure it is saved within the 

Metrics\ICS\projects directory.   

 

 

 

Saving a Project 

The project is a collection of the test method(s) and the data.  To save the data simply select 

File >> Save As and select the directory and filename or to save the currently open project 

simply select the Save toolbar icon. 

 

 
 

 

 


